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CoDeSys V3 Ethernet Driver

* The below Displays are no longer sold nor maintained by Pro-face. To reduce
unplanned downtime due to aged hardware and to maximize your cyber security
environment we recommend replacing your devices with a new, successor model.
For details, please visit our homepage for "Recommended Substitution".
Discontinued from GP-Pro EX 5.00 onwards: GP3000 Series, GP-4100 Series
(Monochrome model), LT3000 Series, ST3000 Series, PL Series, PE4000 Series,
PS2000/3000/4000 Series.

» For details on the Displays supported by the driver, please check the "Connectable
Devices" on our website.
http://www.pro-face.com/trans/en/manual/1064.html

Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described in the sections identified below:

1 System Configuration .
This section lists the types of External "1 System Configuration” (page 3)
Devices and SIO that you can connect.

\ 4

2 External Device Selection &
Select a model (series) of the External "2 External Device Selection” (page 6)
Device and its connection method.

\4

3 || Communication Settings

This section shows setting examples for
communicating between the Display and
the External Device.

\/

4 Setup Items

This section describes communication
setup items on the Display. Set the
Display’s communication settings in GP
Pro-EX or in off-line mode.

\

Operation

¥~ "3 Communication Settings" (page 8)

Fny Setup Items" (page 20)
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1 System Configuration

CoDeSys V3 Ethernet Driver

The system configuration for the Display connected to the CoDeSys Automation Alliance External Device is

shown below.

Communication

Series CPU Link I/F Setting Example
' ' Method MRS
3S-Smart Software Solutions "Setting Example 1"
GmbH PC/AT Ethernet Interface Ethernet (TCP) (ga . S)p
CODESYS Control Win V3 bag
Hitachi Industrial Equipment iggg "Setting Example 1"
Systems Co., Ltd. Ethernet Interface Ethernet (TCP) cttng Sxample
EHV+ 1051 (page 8)
1102
HX-CP1S08
Hitachi Industrial Equipment HX-CP1H16 "Setting Example 2"
Systems Co., Ltd. HX-CP1SO8M | Ethernet Interface | Ethernet (TCP) (ga . 11)p
HX HX-CPIHI6M pag
HXC-CP1H16
Lenze Vertrieb GmbH "Setting Example 1"
Controller 3200C 3200C Ethernet Interface Ethernet (TCP) (page 8)
M241 Ethernet Interface Ethernet (TCP) Setting Example 3
M251 (page 14)
Schneider Electric Modicon -
M262 Ethernet Interface Ethernet (TCP) Setting Example 4
(page 17)

face’s website.

http://www.pro-face.com/product/soft/gpproex/driver/driver.html
* This driver does not support GP3000 Series, LT3000 Series, GP-4100 Series (Monochrome
Model), GP-4*01TM and GP-Rear Module.

* Please refer to the latest list of the External Device to be supported by this driver on the Pro-

B Connection Configuration

¢ 1:1 Connection

GP-Pro EX Device/PLC Connection Manual




CoDeSys V3 Ethernet Driver

¢ 1:n Connection

Maximum number of connections: 16

* 1:n Connection (Gateway connection)

Maximum number of connections: 16

¢ n:1 Connection

Maximum number of connections: n*
AL

—

*  The number of Displays you can connect depends on the External Device. Check the specifications of the

External Device.

GP-Pro EX Device/PLC Connection Manual 4



CoDeSys V3 Ethernet Driver

¢ n:m Connection

Maximum number of connections: n* Maximum number of connections: 16
A

*  The number of Displays you can connect depends on the External Device. Check the specifications of the

External Device.

GP-Pro EX Device/PLC Connection Manual 5



CoDeSys V3 Ethernet Driver

2 External Device Selection

Select the External Device to be connected to the Display.

&% Welcome to GP-Pro EX E
— Device/PLC
Mumber of Devices/PLCs |1 3: ‘
Device/PLC 1
Manufacturer | CoDeSys Automation Aliance |L
Series CoDeSys Y3 Ethernet E
Fart Ethemet (TCF) [l
Eefer to the manual of this Device/PLC
Eecent Device/PLC
4 5
™ Use System Area Device Information

Back [B] | Communication Settings | Mew Logic | Mew Screen I Cancel

Setup Items Setup Description

Use an integer from 1 to 2 to enter the number of Devices/PLCs to connect to the
display.

* When you set up the CoDeSys Automation Alliance CoDeSys V3 Ethernet driver,
the number of drivers that can connect simultaneously is as follows.
* Models that can connect up to 4 drivers: 2
(CoDeSys V3 Ethernet and one other driver)
* Models that can connect up to 2 drivers: 1
(CoDeSys V3 Ethernet only)

Number of Devices/PLCs

Select the manufacturer of the External Device to be connected. Select "CoDeSys

Manuf rer i i
anufacture Automation Alliance".

Select a model (series) of the External Device to be connected and connection
method. Select "CoDeSys V3 Ethernet".

Series Check the External Device which can be connected in "CoDeSys V3 Ethernet" in
system configuration.

& System Configuration" (page 3)

Select the Display port to be connected to the External Device. Select [Ethernet

Port (TCP)].

GP-Pro EX Device/PLC Connection Manual 6
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Setup Items Setup Description

Check this option to synchronize the system data area of the Display and the device
(memory) of the External Device. When synchronized, you can use the External
Device’s ladder program to switch the display or display the window on the Display.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method
Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.
Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] -
[System Area] Settings Guide"
Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area
Settings"

Use System Area

GP-Pro EX Device/PLC Connection Manual 7



3 Communication Settings

CoDeSys V3 Ethernet Driver

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are

shown.

3.1 Setting Example 1
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer IEUD eSps Automation Alliance Series CoDeSys Y3 Ethernet Port IEthemet [TCP)
Text Data Mode IT LChange

Communication Settings

Port Mo, lm ¥ |t

Timeout m [sec]

Fietry m

‘it To Send [ =ims Default |

Device-Specific Settings

Allowveable Mumber Add Device
of Devices/PLCs 16

Mo. Device Mame Settings

[&] 1 Jrco [itz] [Mode Name for] Address=NodeName s Tep/lp=0F]

Add Indirect
Device

GP-Pro EX Device/PLC Connection Manual 8
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|

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the External Device and click [Settings] [ . To connect multiple External Devices, from

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

2% Individual Device Settings

PLC1

PLC Settings

Mode Name (or) Address MNodeMName

[] Use Tepilp
IP Address 0. 0. 0. 0

Port No. 11740 -
[] Use User Management

User

Password b

Gateway Settings
[] Connect via Gateway
IP Address 0. 0. 0. 0

Port No. 1217 =

Tag Data
Use Tag Data

New
Word Order
Double ‘word word order | High word first(H/L) ~
Data Read Update Rate
[] Fixed Update Rate
Update Rate (ms) 100 :

Note:
The total number of variables and array elements allowed to be accessed in the
"Access Rights” setting of the connected device should be 60,000 or less.

Default
=
NOTE * When using a gateway, select the [Connect via Gateway] check box and set the gateway's IP

address and port number.

* While using a display unit other than IPC, PC/AT compatible machine, or SP5000 Series Open
Box and the gateway restarts, communication may not be restored. If that happens, restart the
display unit.

* Use the programming software for the External Device to check the gateway's node name,
node address and IP address.

* Check with a network administrator about IP address. Do not set the duplicate IP address in
the same network.

* Set up the External Device's IP address and Port Number in the [Individual Device Settings]
dialog box.

» Set up the Display's IP address in offline mode.

GP-Pro EX Device/PLC Connection Manual 9
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B Settings of External Device

Use the programming software for the External Device to define its communication settings. Please refer to the

manual of the External Device for more details.

1 Inthe programming software, create a project.
2 Select [Device] from the [Devices] tree view.

3 Click [Scan network] and search for the External Device to use.

NOTE * When searching for External Devices, the External Device and host must exist on the same
network. Please refer to the manual of the External Device for more details.

4 Select the added External Device, and confirm the [Node Name] or [Node Address].

NOTE I * When using a gateway, check the gateway's IP address and port number.

GP-Pro EX Device/PLC Connection Manual 10
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3.2 Setting Example 2
B Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device/PLC 1 |
Summary

Change Device/lPLC

Manufacturer ICoDeSys Automation Aliance

Text Data Mode [2° Chance

Port Ne. |1D24 3: ¥ | At
Timeout I‘ID 3: (sec)

|CoDeSys V3 Ethemet

Retry = |
‘wait To Send ID 3: (ms) Default |
Device-Specific Settings
Allowable Number Add Device
of Devices/PLCs 16
Mo. Device Name Settings
[&] 1 JPc [itz] [Node Name (or) Address=Use Tep/lp=ON,Node IP A

Port [Ethemet (TCP)

Add Indirect
Device

GP-Pro EX Device/PLC Connection Manual
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|

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the External Device and click [Settings] [ . To connect multiple External Devices, from

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

B Individual Device Settings

PLC1

PLC Settings
Mode Name (or) Address

Use Tepllp
IP Address 1592, 168 0. 1
Paort No. 11740 =

[] Use User Management

User

Password b

Gateway Settings
[] Connect via Gateway
IP Address 0. 0. 0. 0

Port No. 1217 =

Tag Data

Use Tag Data
TagDatal1 w

o
Word Order
Double ‘word word order | High word first(H/L) ~

Data Read Update Rate
[] Fixed Update Rate
Update Rate (ms) 100 :
Note:

The total number of variables and array elements allowed to be accessed in the
"Access Rights” setting of the connected device should be 60,000 or less.

Default
0K {0) Cancel
NOTE * When using a gateway, select the [Connect via Gateway] check box and set the gateway's IP

address and port number.

* While using a display unit other than IPC, PC/AT compatible machine, or SP5000 Series Open
Box and the gateway restarts, communication may not be restored. If that happens, restart the
display unit.

* Use the programming software for the External Device to check the gateway's node name,
node address and IP address.

* Check with a network administrator about IP address. Do not set the duplicate IP address in
the same network.

» Set up the External Device's IP address and Port Number in the [Individual Device Settings]
dialog box.

» Set up the Display's IP address in offline mode.

GP-Pro EX Device/PLC Connection Manual 12
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B Settings of External Device
Use the programming software for the External Device to define its communication settings. Please refer to the

manual of the External Device for more details.

1 Createa project in the programming software.
2 From the [Devices] tree view double-click [Device].

3 Click [Scan network] to find the External Device.

NOTE * To search for External Devices, the External Device must be on the same network as the host.
For information, refer to the manual of the External Device.

4 Select the External Device, and click [OK].

S Click [PLC Parameters] and set up the communication port as follows.

Setup Items Setup Description
IP Address 192.168.0.1
Subnet Mask 255.255.255.0
Change IP information | Yes

NOTE * ETHI, ETH2, and ETH3 cannot be set to the same network.

* When changing the IP address, set [Change IP information] to [Yes].

6 From the [Online] menu select [Login], and log in to the External Device.

7 Download the project and restart the External Device.

GP-Pro EX Device/PLC Connection Manual 13



3.3 Setting Example 3
W Settings of GP-Pro EX

4 Communication Settings

CoDeSys V3 Ethernet Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer IEUD eSps Automation Alliance Series CoDeSys Y3 Ethernet Port IEthemet [TCP)
Text Data Mode IT LChange

Communication Settings

Port Mo, lm ¥ |t

Timeout m [zec]

Fietry m

‘what To Send 1} ={ [ms] [efault |

Device-Specific Settings

Allowveable Mumber Add Device
of Devices/PLCs 16

Mo. Device Mame Settings

[&] 1 Jrco [itz] [Mode Name for] Address=NodeName s Tep/lp=0F]

Add Indirect
Device

GP-Pro EX Device/PLC Connection Manual 14
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|

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the External Device and click [Settings] [ . To connect multiple External Devices, from

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

2% Individual Device Settings

PLC1

PLC Settings

Mode Name (or) Address MNodeMName

[] Use Tepilp
IP Address 0. 0. 0. 0

Port No. 11740 &
[] Use User Management

User

Password b

Gateway Settings
[] Connect via Gateway
IP Address 0. 0. 0. 0

Port No. 1217 =

Tag Data
Use Tag Data

New
Word Order
Double ‘word word order | High word first(H/L) ~
Data Read Update Rate
[] Fixed Update Rate
Update Rate (ms) 100 :

Note:
The total number of variables and array elements allowed to be accessed in the
"Access Rights” setting of the connected device should be 60,000 or less.

Default
=
NOTE * When using a gateway, select the [Connect via Gateway] check box and set the gateway's IP

address and port number.

* While using a display unit other than IPC, PC/AT compatible machine, or SP5000 Series Open
Box and the gateway restarts, communication may not be restored. If that happens, restart the
display unit.

* Use the programming software for the External Device to check the gateway's node name,
node address and IP address.

* Check with a network administrator about IP address. Do not set the duplicate IP address in
the same network.

* In the [Node Name (or) Address] field, set the device name of the External Device. You
cannot use the IP address for communication.

» Set up the Display's IP address in offline mode.

GP-Pro EX Device/PLC Connection Manual 15
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B Settings of External Device

Use the programming software for the External Device to define its communication settings. Please refer to the

manual of the External Device for more details.

1 Inthe programming software, create a project.

2 From the [View] menu, select [Navigators]-[Devices tree].

3 From the [Devices tree], double-click the [MyController].

4 Click [Controller selection].

5 Right-click the External Device, and select [Change device name].
6 Input the [Device name].

NOTE I + The setting of Device name have to be identical to that of GP-Pro EX.

7 Click [OK].

NOTE * When communicating with GP-Pro EX, set the Device name for the External Device. IP

addresses cannot be used for communication.

GP-Pro EX Device/PLC Connection Manual 16



3.4 Setting Example 4
W Settings of GP-Pro EX

4 Communication Settings

CoDeSys V3 Ethernet Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer IEUD eSps Automation Alliance Series CoDeSys Y3 Ethernet Port IEthemet [TCP)
Text Data Mode IT LChange

Communication Settings

Port Mo, lm ¥ |t

Timeout m [zec]

Fietry m

‘what To Send 1} ={ [ms] [efault |

Device-Specific Settings

Allowveable Mumber Add Device
of Devices/PLCs 16

Mo. Device Mame Settings

[&] 1 Jrco [itz] [Mode Name for] Address=NodeName s Tep/lp=0F]

Add Indirect
Device

GP-Pro EX Device/PLC Connection Manual 17
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|

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the External Device and click [Settings] [ . To connect multiple External Devices, from

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

2% Individual Device Settings

PLC1

PLC Settings

Mode Name (or) Address MNodeMName

[] Use Tepilp
IP Address 0. 0. 0. 0

Port No. 11740 -
[] Use User Management

User

Password b

Gateway Settings
[] Connect via Gateway
IP Address 0. 0. 0. 0

Port No. 1217 =

Tag Data
Use Tag Data

New
Word Order
Double ‘word word order | High word first(H/L) ~
Data Read Update Rate
[] Fixed Update Rate
Update Rate (ms) 100 :

Note:
The total number of variables and array elements allowed to be accessed in the
"Access Rights” setting of the connected device should be 60,000 or less.

Default
Corce
NOTE * When using a gateway, select the [Connect via Gateway] check box and set the gateway's IP

address and port number.

* While using a display unit other than IPC, PC/AT compatible machine, or SP5000 Series Open
Box and the gateway restarts, communication may not be restored. If that happens, restart the
display unit.

* Use the programming software for the External Device to check the gateway's node name,
node address and IP address.

* Check with a network administrator about IP address. Do not set the duplicate IP address in
the same network.

» Set up the External Device's IP address and Port Number in the [Individual Device Settings]
dialog box.

» Set up the Display's IP address in offline mode.

GP-Pro EX Device/PLC Connection Manual 18
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B Settings of External Device

Use the programming software for the External Device to define its communication settings. Please refer to the

manual of the External Device for more details.

1 Inthe programming software, create a project.

2 From the [View] menu, select [Navigators]-[Devices tree].

3 From the [Devices tree], double-click the [MyController].

4 Click [Controller selection].

5 Right-click the External Device, and select [Change device name].
6 Input the [Device name].

NOTE I + The setting of Device name have to be identical to that of GP-Pro EX.

7 Click [OK].

GP-Pro EX Device/PLC Connection Manual 19
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.
The setting of each parameter must be identical to that of External Device.

&~ "3 Communication Settings" (page 8)

NOTE + Set the Display’s IP address in off-line mode.

Cf.  Maintenance/Troubleshooting Guide "Ethernet Settings"

4.1 Setup Items in GP-Pro EX

B Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer IEUD eSps Automation Alliance Series CoDeSys Y3 Ethernet Port IEthemet [TCP)
Text Data Mode IT LChange

Communication Settings

Port Mo, lm ¥ |t

Timeout m [zec]

Fietry m

‘what To Send 1} ={ [ms] [efault |

Device-Specific Settings

Allowveable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
[&] 1 Jrco [itz] [Mode Name for] Address=NodeName s Tep/lp=0F]
Setup Items Setup Description
Displays the port number of the Display, from 1024 to 65535.
Port No. . .
The port number is set automatically.
) Time (in seconds) that the Display waits for a response from the External Device, from 1 to
Timeout 127
Retr Number of times, from 0 to 255, the Display will re-transmit a command when it does not
y receive a response from the External Device.
. Amount of time, from 0 to 255 milliseconds, the Display waits after receiving a
Wait To Send S e
communication packet before transmitting the next command.
NOTE » Refer to the GP-Pro EX Reference Manual for information on Indirect Devices.
Cf.  GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"

GP-Pro EX Device/PLC Connection Manual 20



@ Device Setting

CoDeSys V3 Ethernet Driver

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] [ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

2% Individual Device Settings

BIE]
PLC Settings
Mode Name (or) Address MNodeMName
[] Use Tepilp
IP Address 0. 0. 0. 0
Port No. 11740 =

[] Use User Management

User

Password b

Gateway Settings
[] Connect via Gateway
IP Address 0. 0. 0. 0

Port No. 1217 =

Tag Data
Use Tag Data

New
Word Order
Double ‘word word order | High word first(H/L) ~
Data Read Update Rate
[] Fixed Update Rate
Update Rate (ms) 100 :

Note:
The total number of variables and array elements allowed to be accessed in the
“Access Rights” setting of the connected device should be 60,000 or less.

Default

QK {0) Cancel

Setup Items

Setup Description

Node Name (or)

Enter the node name or node address of the connected External Device. When you enter the

Address node name or node number, settings such as the IP address become unnecessary.
Use Tcp/lp Select this check box to specify the External Device's IP address and port number.
Set the External Device's IP address.
IP Address
* Check with a network administrator about IP address. Do not set the duplicate IP address.
Port No. Enter the External Device's port number.
a?ai::]gsee;ent Select this check box when the connected External Device performs user management.
User Enter the user name.
Password Enter the password.

GP-Pro EX Device/PLC Connection Manual 21
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Setup Items

Setup Description

Connect via Gateway

When using a gateway, select this check box.

Set the gateway's IP address.

IP Address NOTE
* Check with a network administrator about IP address. Do not set the duplicate IP address.
Port No. Enter the gateway's port number.

Use Tag Data

Select this check box.
Click [New], and import the tag data to use.

&~ m Importing Tag File" (page 30)

Double Word word
order

Select the data storage order of word units for 32-bit data.
When most significant word is first: High word first (H/L)
When least significant word is first: Low word first (L/H)

Variable list registra-
tion optimization

When saving a variable list for the purpose of communication optimization, select this
check box.

* As there is a limit to the number of variable lists that can be saved, enable only for
External Devices that require communication optimization.

GP-Pro EX Device/PLC Connection Manual 22
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4.2 Setup Items in Offline Mode
NOTE * Please refer to Maintenance/Troubleshooting Guide for more information on how to enter

offline mode or about operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"
« The number of the setup items to be displayed for 1 page in the offline mode depends on the

Display in use. Please refer to the Reference manual for details.

B Communication Settings
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the

External Device you want to set from the displayed list.

Setup ltems Setup Description
Displays the port number of the Display, from 1024 to 65535.
Port No. . .
The port number is set automatically.
) Time (in seconds) that the Display waits for a response from the External Device, from 1 to
Timeout 127
Number of times, from 0 to 255, the Display will re-transmit a command when it does not
Retry . .
receive a response from the External Device.
. Amount of time, from 0 to 255 milliseconds, the Display waits after receiving a
Wait To Send S .
communication packet before transmitting the next command.

GP-Pro EX Device/PLC Connection Manual 23
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To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device

you want to set from the displayed list, and touch [Device].

Gomm, Device
CoDeSys V3 Ethernet [TCP] Page 1/1
Device/PLC Name  [PLCT =
Node Address
TGP Connection s [isable Enable
IP Address(Tep) [
Tep Port 11740 » | a |
lserManagement s [isable Enable
Gatemay s [isable Enable
Gateway [P N
Gateway Fort 1217 » | a|
Double Word word order  High word first(H/L)
Update Rateims) B w|al
: 202307/ |5
Enit Back 18:11:47
Setup Items Setup Description
Device/PLC Name Select the External Device to set up. The device name is the name of the External Device
defined in GP-Pro EX. The initial value is [PLC1].
Node Address Displays the node name or node address of the connected External Device.
. Select [Enable] to specify the External Device's IP address and port number.
TCP Connection . . .
When you select [Disable], the [IP Address (Tcp)] and [Tcp Port] properties are disabled.
Set the External Device's IP Address.
IP Address(Tcp) NOTE
* Check with a network administrator about IP address. Do not set the duplicate IP
address.
Tcp Port Enter the External Device's port number.
Select [Enable] when the connected External Device performs user management. Use the
UserManagement user name and password set in GP-Pro EX.
& " @ Device Setting" (page 21)
Gatewa When using a gateway, select [Enable].
y When you select [Disable], the [Gateway IP] and [Gateway Port] properties are disabled.
Set the gateway's IP address.
Gateway IP NOTE
* Check with a network administrator about IP address. Do not set the duplicate IP
address.
Gateway Port Enter the gateway's port number.

GP-Pro EX Device/PLC Connection Manual
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Setup ltems

Setup Description

order

Double Word word

Display the data storage order of word units for 32-bit data.
When most significant word is first: High word first (H/L)
When least significant word is first: Low word first (L/H)

Var. list optimization

When saving a variable list for the purpose of communication optimization, select [Enable].

* As there is a limit to the number of variable lists that can be saved, enable only for
External Devices that require communication optimization.

GP-Pro EX Device/PLC Connection Manual 25



5 Supported Devices
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Range of supported device addresses is shown in the table below. Please note that the actual supported range of

devices varies on the External Device in use. Please check the actual range in the manual for your connected

equipment.

You can import tag data from the project created by your programming software.

[====]) This address can be specified as system data area.

Device Bit Address Word Address 32 bit Notes
Single <TAGNAME> -
<TAGNAME>[x]] -
DAY | 1A GNAME>[xh]
*1
BOOL oD Array | <TAGMNAME>[xLyl] - -
Y | <TAGNAME>[xh,yh]
<TAGNAME>[xl,yl,zl] -
DAY | 1A GNAME>[xh.yh,zh]
. <TAGNAME>.00 -
Single <TAGNAME> 07 <TAGNAME>
1D Array | <TAGNAME>[xI1.00 - <TAGNAME>(x]] -
ELTTE Y | <TAGNAME>[xh].07 <TAGNAME>[xh] -
USINT 2D Arra <TAGNAME>[x1,y1].00 - <TAGNAME>[xLyl] -
Y | <TAGNAME>[xh,yh].07 | <TAGNAME>[xh.yh]
3D Arra <TAGNAME>[xLyl,z1].00 - | <TAGNAME>[xl,yl,zl] -
Y | <TAGNAME>[xh,yh,zh].07 | <TAGNAME>[xh.yh,zh]
. <TAGNAME>.00 -
Single “TAGNAME> 15 <TAGNAME>
<TAGNAME>[x1].00 - <TAGNAME>([x]] - HiL
'S:LT DAY | 1) GNAME>[xh].15 <TAGNAME>[xh] Ll s
WORD oD Array | <TAGNAME>[xIy11.00 - [| <TAGNAME>[xLyI] - [LIH
Y | <TAGNAME>[xh,yh].15 || <TAGNAME>[xh.yh]
3D Array | <TAGNAME>[xlylz1].00 - || <TAGNAME>[xlyl,7I] -
y <TAGNAME>[xh,yh,zh].15 || <TAGNAME>[xh,yh,zh]
. <TAGNAME>.00 -
Single <TAGNAME> 31 <TAGNAME>
1D Array | <TAGNAME>[xI]. 00 - <TAGNAME>{[x]] -
DINT Y | <TAGNAME>[xh].3 <TAGNAME>[xh] -
UDINT
DWORD | op Aray | <TAGNAME>[xLyl.00- | <TAGNAME>[xLyl] -
Y | <TAGNAME>[xh,yh]31 | <TAGNAME>[xh.yh]
3D Array | <TAGNAME>[xlyl711.00 - | <TAGNAME>[x]ylzI] -
Y | <TAGNAME>[xh,yh,7h].31 | <TAGNAME>[xh.yh,zh]
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Device Bit Address Word Address 32 bit | Notes
Single <TAGNAME>
DATE TAGNAME>[x]] -
REAL ) o
TIE 1D Array <TAGNAME>[xh] M
TOD - <TAGNAME>[x1,yl e
xLyl] - LiH
2D Array <TAGNAME>[xh,yh] =
TIME_OF _
DAY <TAGNAME>[xlyl,zl] -
3D Array <TAGNAME>[xh,yh,zh]
Single <TAGNAME>
<TAGNAME>[x]] -
DATE_AND 1D Array <TAGNAME>[xh]
TIME - <TAGNAME>[xl,yl i N
_ 1] -
DT 2D Array <TAGNAME>[xh,yh]
<TAGNAME>[xLyl,zl] -
3D Array <TAGNAME>[xh,yh,zh]
Single <TAGNAME>
<TAGNAME>[x]] -
1D Array <TAGNAME>[xh]
*1
STRING 2D Arra - <TAGNAME>[xLyl] - )
y <TAGNAME>[xh,yh]
<TAGNAME>[x1,yl,z] -
3D Array <TAGNAME>[xh,yh,zh]
. <TAGNAME>.00 -
Single | _TAGNAME>.63 <TAGNAME>
1D Array | <TAGNAME>[x1].00 - <TAGNAME>[x]] -
LINT Y | <TAGNAME>[xh].63 <TAGNAME>[xh] .
LWORD -0
ULINT oD Array | <TAGNAME>[xLy1.00 - | <TAGNAME>[xLyl] -
Y | <TAGNAME>[xhyh].63 | <TAGNAME>[xh,yh]
3D Array | <TAGNAME>[x1.yzI].00 - | <TAGNAME>[xLyl.zI] -
Y | <TAGNAME>[xh,yh,zh].63 | <TAGNAME>[xh,yh,zh]
Single <TAGNAME>
<TAGNAME>[x]] -
1D Array <TAGNAME>[xh]
*5
LREAL oD Arra - <TAGNAME>[x1,yl] - B
y <TAGNAME>[xh,yh]
<TAGNAME>[xl,yl,I] -
3D Array <TAGNAME>[xh,yh,zh]
Single <TAGNAME>
<TAGNAME>[x]] -
1D Array <TAGNAME>[xh]
*5
LTIME 2D Arra - <TAGNAME>[x1yl] - -
y <TAGNAME>[xh,yh]
<TAGNAME>[xlyl,zl] -
3D Array <TAGNAME>[xh,yh,zh]
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Device Bit Address Word Address 32 bit Notes

[
[
WSTRING - <TAGNAME>[xLyl] - -
[
[
[

Single <TAGNAME>

<TAGNAME>[x]] -

1D Array <TAGNAME>[xh]

*6

2D Array

<TAGNAME>[xh,yh]

<TAGNAME>[xLyl,zI] -
<TAGNAME>[xh,yh,zh]

3D Array

*1

*2
*3

*4
*5

*6

<TAGNAME>: When referring to structures, the TagName includes the structure name. The maximum
number of characters for the Tag Name is 255, which includes delimiters and elements.
Example)

BOOL type single symbol "BOOLSYMBOL"

BOOL type 1D Array "BOOL1D[10]

WORD type 2D Array "WORD2D[10,10]

UDINT type 3D Array "UDINT3DJ[0,1,2]

STRING in User Defined Structure [STRUCT001] "STRUCTO001.STRINGSYM"

Set the data storage order of word units for 32-bit data in the Device Setting dialog box.

Initially, 16 words of items are selected for the system data area. When selecting less than 16 words, set
up a tag array with more than 16 words, allocate it to the system data area, and select the items.

64-bit data type on the Display, 32-bit data type on the External Device.

64-bit data type on the External Device, 32-bit data type on the Display. (The Display uses just the
bottom 4 bytes and the top 4 bytes are ignored.)
When a bit is specified, normal writing cannot be performed for 31-bit to 63-bit.

Tag data can be imported. Do not use it, however, since it is the data type which is not supported by the
Display.

IMPORTANT N When connecting with EHV+ Series, arrays cannot be used for the Display.
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-

Naming rules for the Tag Name, Data type name and Scope name are as follows:
* Special characters are not allowed.
* Consecutive underscore ' ' are not allowed.
* You cannot start names with any of the following text:
LS, USR, SCR, PRT
* Maximum 255 characters.
Sub-Scope is shown on the Display as 'Scope'$'Sub-Scope'. ('$' is delimiter)
Imported BIT type variables are converted to BOOL devices. To import BIT type variables,
you need to output a symbol file from the configuration software for CoDeSys Runtime
version 3.5 SP6 or later.
When importing an ENUM data type into the Display, please note the following:
» The member name is converted to ENUMO. The value “0” is assigned to ENUMO.
* If you specify the data type in the data size setting, the value will be handled according to
that type. (e.g. If you specify a data item as a DWORD, it will be treated as 32-bit value.)
* Unspecified data types will be defaulted to 16-bit values.
* 64-bit data types (LINT, LWORD, and ULINT) are not supported and should not be used.

Please refer to the GP-Pro EX Reference Manual on the system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
Please refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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B Importing Tag File

@ 3S-Smart Software Solutions, Lenze Vertrieb, Hitachi Industrial Equipment Systems EHV+ Series
1 Use the programming software to create symbols.

2 Inthe [Devices] tree view, right-click [Application].

3 From the menu select [Add Object]-[Symbol configuration].

4 Move symbols you want to use on the Display to the [Selected variables] area.

5 Build the project and download to the External Device. Symbol data (xml file) is created when downloading.
6 In GP-Pro EX, display the [Individual Device Settings] dialog box and select the [Use Tag Data] check box.

% Individual Device Settings

PLC1

PLC Settings

Mode Name (or) Address

[] Use Tepilp
IP Address 0. 0. 0. 0
Port No. 11740 =

[] Use User Management

User

Password b

Gateway Settings
[] Connect via Gateway
IP Address 0. 0. 0. 0

Port No. 1217 =

Tag Data
Use Tag Data

New =it
Word Order
Double ‘word word order | High word first(H/L) ~
Data Read Update Rate
[] Fixed Update Rate
Update Rate (ms) 100 :

Note:
The total number of variables and array elements allowed to be accessed in the
"Access Rights” setting of the connected device should be 60,000 or less.

Default

OK (0) Cancel
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7 Click [New] to display the [Tag List] window.

Tag List =] 3
Tag Data Mame ITagDataD‘I
[rata type |<AII> j Usage |<AII> 'l lpdate |
Tag |Data typel Scopel
Mame | [1ata type |
Import Expart Expand & Collapse 41 sd | gt | Deliz |
()8 I Cancel |
4

8 Click [Import].

Select File I Browse... |
Tag |Data typel Scopel
Mame | [1ata type |
Select  Unselect Select sl Unselect Al
V¥ LogFile C¥Documents and Settings¥Apes¥iy Documents$ 201 30416-164156. html Browse... | Filter | [Clear Filter, |
()8 I Cancel |
4
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9 From [Select File] click [Browse..], and select the symbol data (xml file).

Select File IE:¥Documents and Settings¥ape#T A0 by P codesys WEF S oftPLCO0T . DevT estO0 App.xml Erowse. . |
Tag |Data typel Scopel
Mame | Data type | -]
AppdGLOBALYVAR —
G_BOOL EOOL
G_BYTE EYTE
G_DATE DATE
G_DATEANDTL.. DATE_&ND_TIME
G_DINT DINT
G_DT DATE_AND_TIME
G_CWwWORD DwiORD
G_INT INT
G_LINT LINT
G_LREAL LREAL
G_LTIME LTIME
G_L'w0ORD LwORD
G_REAL REAL
(™| i SINT SINT LI
Select  Unselect Select &l Unselect Al
V¥ LogFile C¥Documents and Settings¥Apes¥iy Documents$ 201 30416-164156. html Browse... | Filter | [Clear Filter, |
()8 I Cancel |
4
10 Select the symbols you want to import, and click [OK].
Tag List =] 3
Tag Data Mame ITagDataD‘I
[rata type |<AII> j Usage |<AII> 'l Update |
Tag |Data typel Scopel
Mame | [1ata type |
App$GLOBALYVAR
AppfHMISYS
App$l0CONFIG_GLOE...
App$PLC_PRG
AppdPOU
Import Expart Expand Al Collapss & sd | gt | Deliz |
[ o | Cancel |
4

NOTE | ¢ Please refer to "Using Device/PLC Tags" of the GP-Pro EX Reference Manual for the importing
tag.
« Ifthe tag data has been changed using the tool of the External Device, please import the xml file

again.
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@ Hitachi Industrial Equipment Systems HX Series

1 Inthe programming software, create symbols in PLC__PRG.

2 From the [Devices] tree view, right-click [Application].

3 From the menu select [Add Object]-[Symbol configuration].

4 Select the check box of symbols that will be used on the display unit.

5 Build the project and download to the External Device. A symbol data file (xml file) is created at download.
6 In GP-Pro EX, from the [Individual Device Settings] dialog box, select the [Use tag data] check box.

= Individual Device Setti

PLC1

PLC Settings

MNode Mame (or) Address

[] Use Tepilp
IP Address 0. 0. 0. 0

Port No. 11740 -
[] Use User Management

User

Password b

Gateway Settings
[] Connect via Gateway
IP Address 0. 0. 0. 0

Port No. 1217 =

Tag Data
Use Tag Data

Tl
1

New

Word Order
Double ‘word word order | High word first(H/L) ~

Data Read Update Rate
[] Fixed Update Rate
Update Rate (ms) 100 :
Note:
The total number of variables and array elements allowed to be accessed in the
"Access Rights” setting of the connected device should be 60,000 or less.

Default

o
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7 Click [New] to display the [Tag List] window.

Tag List =] 3
Tag Data Mame ITagDataD‘I
[rata type |<AII> j Usage |<AII> 'l lpdate |
Tag |Data typel Scopel
Mame | [1ata type |
Import Expart Expand & Collapse 41 sd | gt | Deliz |
()8 I Cancel |
4

8 Click [Import].

Select File I Browse... |
Tag |Data typel Scopel
Mame | [1ata type |
Select  Unselect Select sl Unselect Al
V¥ LogFile C¥Documents and Settings¥Apes¥iy Documents$ 201 30416-164156. html Browse... | Filter | [Clear Filter, |
()8 I Cancel |
4
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9 From [Select File] click [Browse..], and select the symbol data (xml file).

Select File IE:¥Documents and Settings¥ape#T A0 by P codesys WEF S oftPLCO0T . DevT estO0 App.xml Erowse. . |
Tag |Data typel Scopel
Mame | Data type | -]
AppdGLOBALYVAR —
G_BOOL EOOL
G_BYTE EYTE
G_DATE DATE
G_DATEANDTL.. DATE_&ND_TIME
G_DINT DINT
G_DT DATE_AND_TIME
G_CWwWORD DwiORD
G_INT INT
G_LINT LINT
G_LREAL LREAL
G_LTIME LTIME
G_L'w0ORD LwORD
G_REAL REAL
(™| i SINT SINT LI
Select  Unselect Select &l Unselect Al
V¥ LogFile C¥Documents and Settings¥Apes¥iy Documents$ 201 30416-164156. html Browse... | Filter | [Clear Filter, |
()8 I Cancel |
4
10 Select the symbols you want to import, and click [OK].
Tag List =] 3
Tag Data Mame ITagDataD‘I
[rata type |<AII> j Usage |<AII> 'l Update |
Tag |Data typel Scopel
Mame | [1ata type |
App$GLOBALYVAR
AppfHMISYS
App$l0CONFIG_GLOE...
App$PLC_PRG
AppdPOU
Import Expart Expand Al Collapss & sd | gt | Deliz |
[ o | Cancel |
4

NOTE | ¢ Please refer to "Using Device/PLC Tags" of the GP-Pro EX Reference Manual for the importing
tag.
« Ifthe tag data has been changed using the tool of the External Device, please import the xml file

again.
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@ Schneider Electric

1 Inthe configuration tool, create a symbol.
2 Build the project. On build, symbol data (xml file) is generated.
3 In GP-Pro EX, display the [Individual Device Settings] dialog box and select the [Use Tag Data] check box.

=% Individual D

PLC1

PLC Settings

Mode Name (or) Address

[] Use Tepilp
IP Address 0. 0. 0. 0

Port Ne. 11740 =
[] Use User Management

User

Password b

Gateway Settings
[] Connect via Gateway
IP Address 0. 0. 0. 0

Port No. 1217 =

Tag Data
Use Tag Data

Tl
1

New

Word Order
Double ‘word word order | High word first(H/L) ~

Data Read Update Rate
[] Fixed Update Rate
Update Rate (ms) 100 :
Note:
The total number of variables and array elements allowed to be accessed in the
"Access Rights” setting of the connected device should be 60,000 or less.

Default

o
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4 Click [New] to display the [Tag List] window.

Tag List =] 3
Tag Data Mame ITagDataD‘I
[rata type |<AII> j Usage |<AII> 'l lpdate |
Tag |Data typel Scopel
Mame | [1ata type |
Import Expart Expand & Collapse 41 sd | gt | Deliz |
()8 I Cancel |
4

5 Click [Import].

Select File I Browse... |
Tag |Data typel Scopel
Mame | [1ata type |
Select  Unselect Select sl Unselect Al
V¥ LogFile C¥Documents and Settings¥Apes¥iy Documents$ 201 30416-164156. html Browse... | Filter | [Clear Filter, |
()8 I Cancel |
4
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6 From [Select File] click [Browse..], and select the symbol data (xml file).

Select File IE:¥Documents and Settings¥ape#T A0 by P codesys WEF S oftPLCO0T . DevT estO0 App.xml Erowse. . |
Tag |Data typel Scopel
Mame | Data type | -]
AppdGLOBALYVAR —
G_BOOL EOOL
G_BYTE EYTE
G_DATE DATE
G_DATEANDTL.. DATE_&ND_TIME
G_DINT DINT
G_DT DATE_AND_TIME
G_CWwWORD DwiORD
G_INT INT
G_LINT LINT
G_LREAL LREAL
G_LTIME LTIME
G_L'w0ORD LwORD
G_REAL REAL
(™| i SINT SINT LI
Select  Unselect Select &l Unselect Al
V¥ LogFile C¥Documents and Settings¥Apes¥iy Documents$ 201 30416-164156. html Browse... | Filter | [Clear Filter, |
()8 I Cancel |
4
7 Select the symbols you want to import, and click [OK].
Tag List =] 3
Tag Data Mame ITagDataD‘I
[rata type |<AII> j Usage |<AII> 'l Update |
Tag |Data typel Scopel
Mame | [1ata type |
App$GLOBALYVAR
AppfHMISYS
App$l0CONFIG_GLOE...
App$PLC_PRG
AppdPOU
Import Expart Expand Al Collapss & sd | gt | Deliz |
[ o | Cancel |
4

NOTE | ¢ Please refer to "Using Device/PLC Tags" of the GP-Pro EX Reference Manual for the importing
tag.
« Ifthe tag data has been changed using the tool of the External Device, please import the xml file

again.
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|

6 Device Code and Address Code

Device code and address code cannot be used.
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7 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error

Occurrence Area)". Each description is shown below.

ltem Description

No. Error No.

Name of External Device where error occurs. Device name is a title of External Device set

Device Name with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Displays IP address or device address of External Device where error occurs, or error codes
received from External Device.

Error Occurrence Area NOTE

 IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
» Device address is displayed such as "Address: Device address".
* Received error codes are displayed such as "Decimal [Hex]".

Display Examples of Error Messages
"RHAAQ35: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE » Refer to your External Device manual for details on received error codes.
» Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the

error messages common to the driver.

B Error Messages Unique to External Device

Message ID Error Message Description

This message appears when the Display cannot
communicate with the External Device, or when
communication is interrupted.

Check the External Device settings.

(This message appears when using the node
address or the node name for communication
with the External Device.)

(Node Name): Connection open error

RHxx128 (Node: %s)

(Node Name): %s:Symbol mismatch with | This message appears when accessing a symbol
RHxx129 Device/PLC. Please update TagData in that does not exist.
the project. Make sure the tag data matches the symbol file.

This message appears when writing an out of
range value.
Check the write values.

(Node Name): %s:Out of range value in

RHxx130 write request (Address:%s)
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